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1.	 About SigmaStudio™

SigmaStudio™ is a graphical development tool designed by Analog 
Devices to program SigmaDSP® audio processors.

The software includes an extensive library of algorithms to 
perform audio processing such as filtering, mixing, and dynamic 
processing, as well as basic low-level DSP functions and controls.

All these algorithms are available as processing blocks that  can 
be wired together as in a schematic: this means that you are not 
forced to use a predefined signal processing path but you can 
freely decide each and every single detail of it, determining the 
amount of filters, eq, limiters or delays depending on your actual 
needs and the amount of resources available.

The compiler takes care of generating DSP-ready code and a 
control surface for setting and tuning parameters in real time, 
listening to the result of the changes you make.

This tool allows engineers with no DSP code writing experience 
to easily implement a DSP into their design while still remaining 
powerful enough to satisfy the demands of more experienced 
DSP designers.

1.1.	 SigmaDSP® processors

SigmaDSP represents a wide family of processors, used in many 
different audio and automotive applications. For this reason some 
of the features and algorithms available in the software are not 
strictly required by loudspeaker manufacturers or other pro-audio 
applications designers.

This document provides information and guidelines specific for 
using SigmaStudio with  the  SigmaDSP  processors adopted in 
Powersoft products.

ADAU 1701: used in DSP-C board, included in all Digimod IS 
Series amp modules and M Series rack amps, and compatible 
(optional) with all DigiMod Series amp modules.

ADAU 1702: used (optional) in all D-Cell504 and D-Cell504 IS 
Series amp modules.

1.2.	Where and how to download the software

Typically SigmaStudio is freely distributed by Analog Devices and 
is downloadable from the Analog Devices website provided you 
supply the software key supplied when you purchase one of the 
Analog Devices evaluation kits.

Powersoft has a license agreement with Analog Devices 
for redistributing the software exclusively  to Powersoft 
customers  without the need of purchasing an Analog Devices 
evaluation board. That is the reason why you will not find a direct 
public link on Powersoft website to download the software.

In order to obtain the link to download your copy of SigmaStudio, 
please contact Powersoft at the following address: 

support@powersoft.it

1.3.	 System requirements and SigmaStudio compatibility with 
Powersoft products

The latest  SigmaStudio version compatible with Powersoft DSP 
products is 3.3 . In order to run this version of the software your 
machine should meet the following requirements:

▶▶ Operating System: Windows 2000 with SP4, Windows ME; 
Windows Server 2003, Windows XP / XP Professional or 
Home edition with SP2; Windows Vista; Windows 7 without 
SP1.

▶▶ .NET Framework 3.5
▶▶ CPU : AMD X86-64 Series / Intel X86 series. Both 32-bit and 
64-bit platforms are supported

▶▶ RAM : minimum 128MB (256MB recommended).
▶▶ Disk Space : 45MB of available hard disk space.
▶▶ Screen Resolution : 1024x768.
▶▶ External Interface : USB 1.1/2.0 data port

1.4.	 Help and support for SigmaStudio

Along with this documentation, a number of other resources can 
be used to deepen the knowledge of SigmaStudio, getting more 
details about algorithms and techniques, optimizing your design or 
just asking for support and troubleshooting.

▶▶ SigmaStudio Help file: SigmaStudio has an extensive Help file 
included with the installation, explaining the operation of all 
of the software’s features and signal processing blocks. You 
can access the Help file in the Help menu software (shortcut 
F1), or opening the file located in the Help folder inside your 
SigmaStudio installation folder

▶▶ SigmaStudio Preset Templates specifically designed for use 
with Powersoft products, described in Section 5.

▶▶ Any help and support request for the use of SigmaStudio 
with Powersoft products can be addressed to:  
support@powersoft.it 

▶▶ General information about the SigmaDSP processors can be 
found in the SigmaDSP FAQ page of Analog Devices website:  
 
ht tp: //www.analog.com/en/technical -documentat ion/
f r equent l y -and - r a r e l y -a s ked -ques t ions /r esour ces /
e mbedd ed - p r o ce s s i n g - d s p /s i g mad s p / l i s t i n g . h t m l 

▶▶ Further SigmaDSP or SigmaStudio support inquiries can 
be directed to EngineerZone forum (http://ez.analog.com/
community/dsp/sigmadsp)
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2.	 Installing SigmaStudio 3.3 and Powersoft 
programming boards

2.1.	 Software and drivers installation

Send an email to support@powersoft.it to obtain the link to 
download the SigmaStudio 3.3 Installer Package. 

The file is called SigmaStudio_3.3.zip and is approximately 50,5MB 
in size.

After unzipping the file, the folder ‘SigmaStudio_3.3’ will contain 
two additional zip files:

▶▶ SigmaStudio 3.3 X64 - only for AMD X86-64 microprocessors.
▶▶ SigmaStudio 3.3 X86 - only for Intel X86 microprocessors.

After unzipping the file corresponding to your system’s 
characteristics, a folder called ‘Sigma Studio v3.3 xxx 
Release’ will appear: Launch the installer by double 
clicking the ‘Sigma Studio.msi’ file inside that folder. 

 

▶▶ Click “Next” to continue.

▶▶ Click “Next” to continue.

Read the SigmaStudio End User License Agreement.  Select 
‘I Agree’ and click “Next” to continue, “Back” to return 
at previous window or “Cancel” to quit the installation.

 
 
 

▶▶ Select the folder where you want to install “Sigma Studio 
3.3”: click “Browse” to search a different folder in your 
computer or “Disk Cost…” to select another hard disk on 
your computer. 

▶▶ Select whether you want to install “Sigma Studio 3.3” on your 
account or anyone else using the computer. 

▶▶ Click “Next” to continue, “Back” to return to previous 
window or “Cancel” to quit the installation.

▶▶ Click “Next” to start the installation, “Back” to return to 
previous window or “Cancel” to quit the installation.
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▶▶ Please wait for the installer to complete the operation. 

▶▶ Start the device USB drivers’ installation. Click “Next” to 
continue or “Cancel” to quit the installation.

▶▶ Once the drivers are successfully installed, click “End” to 
complete the installation or “Cancel” to quit the installation.

▶▶ Now, “Sigma Studio 3.3” is installed in your computer. Click 
“Close” to exit.

2.2.	Verify software installation

Launch Sigma Studio by clicking the Sigma Studio icon in Start’ 
menu > All Programs > Analog Devices > Sigma Studio 3.3 > 
Sigma Studio.

If after launching Sigma Studio 3.3 a window appears with the 
message shown in the image above, it means that the .NET 
Framework installed in your system is not compatible with Sigma 
Studio 3.3.
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Use Windows Update to check for any critical updates to the 
.NET Framework, or install the version 3.5 from the following link:

http://www.microsoft.com/download/en/details.aspx?id=21

If a window appears with the message shown in the figure above, 
then the minimum .NET Framework requirement (3.5) is no 
longer installed.

Please proceed as indicated above to update your .NET 
Framework to the proper version.

2.3.	Connecting and installing drivers to use Powersoft’s 
programming boards

In order to program the DSP used in Powersoft products*, you 
will need the following tools:

▶▶ DSP Programming Board LITE or DSP Programming Board 
PRO

▶▶ DSP programming cable - a flat cable available from Powersoft 
for connection to DSP-C (through micromatch connector) or 
to interface panel of IS versions of the amp modules (through 
20 poles DIL connector)

▶▶ USB cable (not provided by Powersoft)

The following instructions are valid for both “Programming Board 
LITE” and “Programming Board PRO”.

2.4.	 Installing the programming board

▶▶ Connect the Powersoft amplifier* to mains
▶▶ Connect the programming board to the amplifier using the 
flat cable

▶▶ Connect the programming board to your computer with a 
USB cable

▶▶ Switch on the amplifier

* See Section 1.1 of this User Guide to see a list of Powersoft products 
compatible with SigmaStudio.

2.5.	Windows XP with SP2

▶▶ As soon as you switch on the amplifier, the system detects 
the programming board as an external USB device.  
Note: the name of device can be different from the one 
shown in the picture above.

ù

▶▶ The “Found new Hardware Wizard” appears. Select the 
option “No, not this time”, to avoid the installation of generic 
drivers instead of the ones needed for the programming 
board. Press Next to continue.

 

▶▶ Select the option “Install from a list or specific location 
(Advanced)”. Click “Next” to continue.
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▶▶ Select “Don’t search. I will choose the driver to install”. Click 
Next to continue.

▶▶ Click “Have a Disk” to tell the system where to find the 
drivers.  

▶▶ Click the “Browse” button.

▶▶ Browse your system and find the folder called “USB drivers” 
inside the SigmaStudio installation folder. Usually, the default 
path is C:\\Program files\Analog Devices\Sigma Studio 3.3\
USB Drivers. Select the file CyUSB and click “Open”.

▶▶ Click “Ok” to confirm the correct drivers location.

 

▶▶ Click “Next” to continue.
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▶▶ If the window above appears, click “Continue Anyway”.

▶▶ Please wait for the drivers being installed.

▶▶ Click “Finish” to end the installation.

▶▶ Your PC should now confirm the correct installation.

2.6.	Windows Vista

▶▶ As soon as you switch the amplifier on, the system detects 
the programming board as an external USB device and 
the  “Found new Hardware Wizard” utility appears. Select 
the option “Ask me again later”.

▶▶ PC starts automatic installation of the drivers. Click the 
balloon appearing on the bottom right of your screen 
(“Installing device driver software”) to see the status of the 
installation.

▶▶ Click Close to stop the automatic installation of generic 
drivers.
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▶▶ Click “I don’t have the disk. Show me other options”.

▶▶ Choose the second option, “Browse my computer for driver 
software (advanced)”.

 

▶▶ Click “Browse” to locate the drivers folder.

▶▶ Browse your system and find the folder called “USB drivers” 
inside the SigmaStudio installation folder. Usually the default 
path is C:\\Program files\Analog Devices\Sigma Studio 3.3\
USB Drivers. Select the file CyUSB and click “Open”.

▶▶ Click “Next” to continue the installation.

▶▶ Click “Continue anyway”.
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▶▶ Please wait for the drivers being installed

▶▶ Click “Close” to complete the installation. 

▶▶ Your PC should now confirm the correct installation.

2.7.	 Verifying correct installation of the programming board

To verify that the programming board is correctly installed and 
communicates with SigmaStudio, open one of the templates 
provided by Powersoft (see Section 5 for more details) and take 
the following steps:

▶▶ Click the Hardware configuration tab located on the top side 
of the workspace.

▶▶ Check the color of the label in the block “Evalboard170x/140x”

✓✓ If the color of the label is orange, then there is proper 
communication between the programming board and 
SigmaStudio.

✓✓ If the color of the label is red, there is no communication. 
In this case please verify that both USB cable and DSP 
programming cable are properly connected, then proceed 
with a manual update of the drivers as explained at the end 
of this section.

2.8.	Troubleshooting: update drivers

▶▶ Windows XP

▶▶ Open the Control Panel and click the ‘System’ icon to open 
the System Properties window. Select ‘Hardware’ tab and 
click ‘Device Manager’ button.
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✓✓ If the programming board is not communicating with the 
PC, there are two possible reasons: either no drivers have 
been assigned to the programming board, or the board has 
been recognized as a different device and generic drivers 
have been assigned to it. In the first case, you should see a 
device with a yellow question mark under “Other devices”. 
In the second you should find the device under  “Universal 
Serial Bus Controller” submenu. If you are unsure about 
which device corresponds to the programing board, simply 
disconnect the USB cable from PC and connect it again. The 
device disappearing from the list and showing up again is the 
programming board.

▶▶ Right click the device and select “Update Driver…”. The 
installation assistant will start, and you can follow the 
procedure from second paragraph of section 2.3.2

▶▶ Windows Vista

▶▶ Open the Control Panel and click the ‘System’ icon to open 
the System Properties window. Click on ‘Device Manager’.

✓✓ If the programming board is not communicating with the 
PC, there are two possible reasons: either no drivers have 
been assigned to the programming board, or the board has 
been recognized as a different device and generic drivers 
have been assigned to it. In the first case, you should see a 
device with a yellow question mark under “Other devices”. 
In the second you should find the device under “Universal 
Serial Bus Controller” submenu. If you are unsure about 
what device corresponds to the programing board, simply 
disconnect the USB cable from PC and connect it again: the 
device disappearing from the list and showing up again is the 
programming board.

▶▶ Right click the device and select “Update Driver…”. The 
installation assistant will start, and you can follow the 
procedure described in Section 2.4 .
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3.	 Getting Started: setting up SigmaStudio and 
creating a new project

In this section you can find the instructions to learn the basics of 
SigmaStudio 3.3, in order to optimize the workflow: a complete 
description of each algorithm available in SigmaStudio can be 
found in the Help file accessible directly from the software by 
clicking on the Help menu or by pressing F1.

Also, instructions to start a new project from scratch are 
described in this section: however, please note that a complete set 
of templates (see Section 5) is available to help the user starting 
the design process with no need to perform all the project set up.

3.1.	 Arranging the Worspace

When SigmaStudio is opened for the first time, the 
above layout will be presented, with no project open.  
Create new project in File > New Project.

The Program Window should look very similar to the one shown 
in the picture. You can see four different areas, indicated in the 
previous picture by four different dashed lines.

▶▶ The yellow rectangle indicates the Tree ToolBox area, where 
you can find the basic building blocks to design your project.

▶▶ The green rectangle is the actual Workspace, showing 
different information depending on which Tab you select right 
above the Workspace itself: the Hardware Configuration Tab 
to set up the communication between the software and your 
programming board, and the Schematic Tab to create your 
DSP design by dragging blocks from the Toolbox window.

▶▶ The purple rectangle is the Output window.
▶▶ The blue rectangle is the Capture window, displaying in 
real time the data sent and received by the software. 

▶▶ Schematic Status Bar

Placed below the workspace, the schematic status bar displays 
the state of the schematic design as well as indicating USB 
communication status. There are five status states:

▶▶ Design Mode - indicates that the schematic design has been 
modified and recompile is required to validate the current 
design. The schematic status bar color is blue.

▶▶ Ready: Compiled - indicates successful compilation when 
using the “Link Compile Connect” operation. The Program 
data is “ready” to be exported to files or downloaded to the 
hardware. The schematic status bar is green.

▶▶ Active: Downloaded - indicates that the schematic design was 
successfully compiled and that the program data successfully 
downloaded  to hardware (if USB hardware is connected). 
The schematic status bar color is bright green.

▶▶ Computation Error - displayed when an internal schematic 
design error or a fatal USB communication error occurs.  
Typically this happens when an invalid or out-of-range 
numerical value is specified for an algorithm parameter.
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▶▶ ToolBoxes

SigmaStudio offers two different ways to access the algorithms 
library: the “Tree ToolBox” and the “ToolBox”.

They both have the same functionality and building blocks, but 
using the Tree ToolBox is recommended, since it is designed to 
simplify the design process. The Tool Boxes can be shown/hidden 
from the View Menu or by clicking Ctrl+1 and Ctrl+2).

3.2.	Setting the sample rate

Verify that the sample rate is set to 48khz. 

The sample rate on the SigmaDSP used in Powersoft DSP 
boards are locked to this value, being the best trade-off between 
performances and resource available. 

Choosing a different value from the software does not change the 
sample rate the board operates at.

3.3.	Creating a new project

▶▶ Launch SigmaStudio and create a new project. The Hardware 
Configuration tab and workspace will display.

▶▶ Drag an ADAU1701/02 and an EvalBoard170x block from the 
“Tree Toolbox” area at the left of the Program Window, into 
the workspace.

▶▶ Connect the EvalBoard170x to the ADAU1701/02 block by 
clicking and dragging from the top blue output pin to the 
green input pin.

▶▶ Click Schematic (tab at the top of workspace) to start building 
the project.

4.	 Building/Modifying Schematics

This section presents the fundamental concepts of SigmaStudio  
and explains the basic operation that can be done with the 
algorithms and blocks in order to build a complete project.

4.1.	 Schematics Blocks

Schematic Blocks are used to build a SigmaStudio design. The 
blocks available for each processor are displayed in the ToolBox 
and Tree ToolBox windows and can be dragged and dropped into 
the schematic. 

Each block represents one or more algorithms: a block that 
contains no algorithms will have no controls or input/output pins. 

▶▶ Pins 
Each schematic block can contain one or more pins used to 
connect the blocks together. Pins are used to route audio and 
control data in the schematic flow.  
There are 3 different types of pins:

▶▶ Input Pin (Green)
▶▶ Output Pin (Blue)
▶▶ Control Data Pin (Orange)

Output pins can only connect to Input pins and viceversa. Typically, 
control data pins are only connected to other control data pins, 
but it is possible to connect an audio data pin to a control data pin 
and a control data pin to an audio data pin when necessary.

Hover over a block’s pin with the cursor to display the pin’s tool-
tip which includes the pin number, unique name, and signal data 
type.

▶▶ Naming

To change the name of a block, double click on the block label and 
type a new name. Note that within each hierarchy board all block 
names must be unique. You will see an error dialog if you attempt 
to use a name that is already present in the current window.
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▶▶ Selecting

To select a block, click its border or label. To select multiple blocks, 
hold down the Shift or Ctrl key while clicking. You can also click 
in the schematic window and drag a box around blocks to select 
them , this will select any blocks that are in the selected screen 
area. To select all block you can press Ctrl + A or use the Select 
All button in the Schematic Layout toolbar. Selection is indicated 
by a light-green outline.

▶▶ Deleting

To remove a block from the schematic select the block and then 
press the Delete key. You can also remove selected blocks by 
choosing Edit - Cut from the main application menu or by pressing 
Ctrl + X.

▶▶ Action Menu

Right-click on a block to bring up the block’s pop-up menu. This 
menu includes items for control Settings, Add/Remove Algorithm, 
Grow/Reduce Algorithm, Changing IC, and Cut/Copy/Paste 
editing.

▶▶ Layout

You can change the position of a block by selecting it with the 
mouse and dragging it to a new screen location. Use the schematic 
layout toolbar buttons to align groups of blocks in your schematic. 
Alignment is applied to all selected blocks. The blocks with a blue 
outline will be aligned to the block with a green outline.

▶▶ Controls 
Blocks can contain a variety of controls for editing algorithm 
parameters.

▶▶ Spin Controls

Spin controls allow you to change values either by entering the 
value directly in the edit-box or by clicking the left/right or up/
down arrows. You can left-click and hold an arrow to make large 
adjustments or click-hold-drag to increase the rate of change. A 
grey control (for example the top control shown below) means 
the control is disabled and the value cannot be changed for the 
current algorithm.

▶▶ Knobs & Sliders

To change the value of knobs or slider control, click and hold the 
left mouse button on the control and drag to adjust the value. 
You can also change the knob or slider control’s value, range, and 
step size. To modify the knob or slider settings, right-click on the 
control which displays the control pop-up window.

▶▶ Pop-up Control Windows

Some blocks include pop-up control windows providing advanced 
functionality, for example the General 2nd Order filter. To open a 
block’s advanced control window, click on the icon button.



▶▶ 14

SigmaStudio™ User Guide

4.2.	Algorithms

Algorithms range from very simple, like Signal Add, to advanced 
system components like Dynamic Bass. You can add or remove 
algorithms from blocks to meet your specific requirements. 

A block that contains no algorithms will have no controls or pins 
and you will only see the block’s name (as shown in the figure 
below). You must add an algorithm to empty blocks before they 
can be used in the schematic design..

Algorithms can be “added/removed” from a block, or “grown/
reduced”: it is important to understand the difference between 
these operations, described below.

▶▶  selecting the DSP IC for the algorithm.

At this point, right-click the block on its border or label to add 
another algorithm if desired. (It is important to right-click the 
border or label; if you right-click the center, you may display the 
pop-up window for entering parameters values).

▶▶ Remove Algorithm 
It is also possible to remove algorithms from blocks. To 
remove an algorithm, right-click the block and select 
Remove Algorithm. This will remove the last algorithm 
(bottom pins) which is the algorithm that was added most 
recently. If the block contains only one algorithm, removing 
the algorithm will result in an empty block.

▶▶ Grow Algorithm 
Growing algorithms means building upon the existing 
algorithm of the block, keeping the same algorithm in place 
(expanding upon it) and the same DSP association (Adding 
algorithms does neither). To grow an algorithm, right-click 
the block and select Grow Algorithm > (algorithm name) 
> (grow amount). Note that growing is not available for all 
algorithms. 

▶▶ The easiest way to understand the distinction 
between adding and growing is with a mixer block. 
Drag a Cross Mixer (2 Inputs) into the workspace.  

✓✓ Growing the mixer creates more mixer output pins. 
Essentially you are creating extra mixer output channels that 
share a common input. There is still only a single algorithm in 
the block. 

✓✓ Adding an algorithm creates separate algorithms that share 
the control window, but do not share inputs/outputs pins 
or resources. In the mixer example, an additional input pin, 
output pin and a cross-mixer control are added to the block.

4.3.	Wires

SigmaStudio schematic designs are built from blocks which are 
connected together with “wires”. Wires define the systems’s 
signal flow. 

▶▶ Creating a schematic wire

Move the mouse cursor over a block’s pin so the wire icon is 
displayed. Next, left-click on a block pin, and while holding 
the mouse button, drag the cursor to another blocks’s 
corresponding pin. Input pins can only connect to Output 
pins and Output pins can only connect to Input pins.

▶▶ Selecting

To select a wire, click on it with the left mouse button. Selected 
wires are indicated by green squares (points) as shown below. 

▶▶ Position

To change the position of a wire, place the mouse cursor over 
a point. Next, left-click on the wire point, and while holding the 
mouse button, drag the cursor to reposition the wire.
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▶▶ Menu
Right-click on a wire to bring up the wire menu. This menu 
includes following commands: 

✓✓ Delete = Removes the wire.

✓✓ Insert Point = Adds an additional layout point to the wire at 
the current position.

✓✓ Remove Segment = Remove a line segment created by 
inserting a point.

✓✓ Enable Auto Layout = Resets any custom positioning allowing 
the wire to layout automatically.

✓✓ Align to Source / Destination Pin = Moves the Source or 
Destination block so the Input and output pins are aligned.

▶▶ Wire colors

Wires are colored according to their associated DSP processor. 
The input and output pins of the wire must be associated with the 
same DSP or you will not be able to create a wire between the 
pins. Projects with more than one processor IC will have distinct 
colors for each IC.

4.4.	 Simulation Stimulus/Simulation Probe

The Simulation Probe is used in conjunction with the Simulation 
Stimuli to plot the frequency response of the system you configure.

“Simulation Stimuli” is used to send a virtual signal, to verify the 
behavior of the virtual circuit. The signal is generated upon clicking 
the button “Stimulus”.

“Simulation Probe” is used to display the response to the virtual 
signal generated by the Stimulus and processed by the algorithms 
belonging to the path from the Stimulus to the Probe. 

The Simulation Probe has to be place before any limiter block. 

Clicking the Probe icon will open the Simulated Frequency 
Response window.

Magnitude and phase response can be displayed both individually 
or in the same graph by clicking on the tabs located on the top of 
the window.
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In order to display the response of two or more signals 
(corresponding to different Stimulus Blocks) in the same Simulation 
Probe window,  right-click on the “Simulation Probe”, and select 
add pins.

5.	 Using SigmaStudio Preset Templates

SigmaStudio Preset Templates are project files created to allow 
for a quick and easy development of DSP presets for  Powersoft 
amplifier modules.

The templates provide a schematic including the most common 
algorithms typically needed by a loudspeaker designer to process 
the signal, from filters and crossovers to limiters and delays.

Input and output blocks are properly designed for the specific 
configuration, guaranteeing a consistent gain structure and phase 
behavior for all models: in addition to this, the SigmaStudio Preset 
Templates include Powersoft proprietary processing (Tandem 
Technique*) designed to maximize the noise floor performances 
of the amplifier.

The templates can be used as a predefined processing structure 
where the loudspeaker designer only has to set the parameters 
accordingly to the project requirements and specifications, as 
well as a starting point to develop a custom preset by modifying, 
adding or deleting parts of the template.

SigmaStudio Project Templates are available for all Powersoft 
amplifier modules in different input/output configurations, in 
order to cover most of the applications for each model.

*Tandem Technique is only available for DSP-C.

5.1.	 Finding and downloading the SigmaStudio Project Templates 

The files can be downloaded from Powersoft website, either in 
the specific amplifier page (where a .zip file containing all templates 
for that model is available) or from the webpage dedicated to 
SigmaStudio, where all available packages are listed :

http://www.powersoft-audio.com/en/products/software/dsp-
programming-software.html

Please contact Powersoft if any support is needed to find a proper 
template: support@powersoft.it

5.2.	Description of the SigmaStudio Preset Templates

All SigmaStudio Project Templates share the same structure, 
consisting in the following processing stages:

▶▶ Input Section
▶▶ Input EQ 
▶▶ Crossover
▶▶ Output EQ
▶▶ Alignment Delay
▶▶ Dynamic Processing
▶▶ Output Section

All sections are briefly described hereinafter: the content of some  
of them are password locked in order to protect Powersoft 
proprietary processing or to keep the template compact and easy 
to read.

▶▶ Input section

The input section of the templates consists of a locked hierarchy 
board, containing the blocks needed for proper input signal 
routing required by the specific application.

When the Tandem technique is used, the Input section includes 
the Powersoft proprietary processing implementing such a 
technique. 

▶▶ Input EQ

The Input EQ is a block containing three algorithms, each one 
implementing a double precision single order filter. The number 
of filters can be changed by right-clicking the block and choosing 
“Grow/Reduce Algorithm” (see Section 4.2 for details).

Click on the icon button to open the filter control window, where 
the filter type can be selected among the ones listed below:

▶▶ Parametric
▶▶ Shelving
▶▶ General High-Pass
▶▶ General Low-Pass
▶▶ General Band-Pass
▶▶ General Band-Stop
▶▶ Butterworth Low-Pass / High-Pass 
▶▶ Bessel Low-Pass / High-Pass
▶▶ Tone Control
▶▶ IIR Coefficient (direct coefficient entry)
▶▶ 1st-Order Low-Pass / High-Pass
▶▶ All-pass
▶▶ Peaking
▶▶ Notch
▶▶ Chebyshev Low-Pass / High-Pass
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Each filter can be switched on and off by clicking the small circle 
on the top left corner of the block (the filter is on when the circle 
is blue, off if the circle is orange). Click the blue filter response icon 
to switch among highpass, lowpass or flat response).

▶▶ Crossover

The Crossover block is used in both 2-way and 3-way versions 
depending on the application the template is designed for.

It implements the filters typically used in loudspeaker system to 
split the audio signal into separate frequency bands. This filter 
provides:

▶▶ 2-way or 3-way crossover filtering
▶▶ Graphical design of crossover response
▶▶ Selectable crossover types: Linkwitz-Riley, Butterworth, 
Bessel

▶▶ Selectable filter orders: 2nd, 3rd, 4th, 6th, and 8th

The Crossover Control Window can be opened by clicking the 
blue icon button.

▶▶ Output EQ

This section contains by default 4 second-order filters algorithms.
The number of filters can be changed by right-clicking the block 
and choosing “Grow/Reduce Algorithm” (see Section 4.2 for 
details).

Click on the icon button to open the filter control window, where 
the filter type can be selected among the ones listed below:

▶▶ Parametric
▶▶ Shelving
▶▶ General High-Pass
▶▶ General Low-Pass
▶▶ General Band-Pass
▶▶ General Band-Stop
▶▶ Butterworth Low-Pass / High-Pass 
▶▶ Bessel Low-Pass / High-Pass
▶▶ Tone Control
▶▶ IIR Coefficient (direct coefficient entry)
▶▶ 1st-Order Low-Pass / High-Pass
▶▶ All-pass
▶▶ Peaking
▶▶ Notch
▶▶ Chebyshev Low-Pass / High-Pass

✓✓ Single Precision or Double Precision ?
Most of the filters will let you select between double- and single-
precision computation. If there are available system resources, 
double-precision should normally be used: it uses 56 bits for each 
calculation and takes 10 instructions per filter. Single-precision uses 
28 bits for calculations, takes 6 instructions per filter, but saves 
you 3 RAM spaces over the double-precision algorithm. Single-
precision should not be used for signal content below 200Hz.

▶▶ Dynamic Processing 

The Dynamic Processing section basically consists in one or more  
RMS or Peak Limiters, depending on the application. 

Click “Show Graph” in the Peak Limiter block to open the 
Compression Curve window. Right-click along the curve to add or 
remove control points according to your needs.

The limiters used in SigmaStudio Preset Templates have been 
tested by Powersoft and their behavior has been measured to be 
used as a reference in the paper “Limiters Settings in SigmaStudio”, 
containing the guide lines to properly set the limiters parameters 
depending on the specifications of the speakers used.



▶▶ 18

SigmaStudio™ User Guide

Powersoft highly recommends the use of these very algorithms 
and guide lines in order to implement dynamic processing in 
SigmaStudio.

▶▶ Alignment Delay

This block is intended to be used for speaker alignment purposes.

The input signal applied to this algorithm is delayed by the amount 
of samples reflected in the Real numeric text box. The top drop-
down menu labeled Max represents the largest amount of delay 
that could be applied to the input signal since it is the size of the 
data delay buffer being stored. 

Since the sampling rate used in Powersoft DSP is 48kHz 
(corresponding to 48000 samples per second, that is 48 samples 
per millisecond), the amount of delay needed in ms can be easily 
converted in samples by using the formula:

Delay in samples = 48 X (Delay in ms)

Setting the Max control’s value, allocates memory on the DSP, 
reserving that memory for use by this particular block only, and 
reducing the available memory for all other delay blocks in the 
design: in order to avoid any waste of memory, it is recommended 
to set the Max with the same value used in Real numeric text box.

▶▶ Output

The output section of the templates consists in a locked hierarchy 
board, containing the blocks needed for proper output signal 
routing required by the specific application.

The block can contain one or more DAC outputs depending 
on the application: for example, in a subwoofer design where 
the speaker is connected using the two output channels of the 
amplifier in bridged mode, the signal is routed (inside the Output 
block) to both outputs of the DSP.

6.	 Listening, adjusting and storing Presets

Before a complete design can be evaluated, it must be linked, 
compiled, and downloaded to the hardware.  To perform all 
these steps in a single operation, use the Link Compile Download 
command described below.

6.1.	 Link/Compile/Download

To download the project, press the Link Compile Download 
toolbar button, select Action - Link Compile Download from the 
main menu, or press F7.  This performs the link step, compiles the 
project, and sends the design code from the schematic to the DSP 
hardware.

Once the project has been downloaded to the DSP, the system 
will be responsive to any real-time changes made to controls 
(sliders, knobs, etc.) in the schematic workspace, allowing to 
adjust parameters in real time, perform A/B realtime comparison 
between different projects, and store the preset into the DSP.

Any time an edit is made in the schematic (e.g. add/remove blocks, 
add/remove wires, add/remove algorithms) the project has to be 
recompiled and downloaded before these changes will take effect 
in the hardware program.  

The status of the link is displayed in the Schematic Status Bar 
below the workspace. When the schematic status bar color is 
bright green, the schematic was both successfully compiled and 
that the program data was successfully downloaded  to the DSP.

If the application status bar does not indicate “Active Downloaded”, 
the downloaded program and schematic design are out of sync.

6.2.	Real-Time A/B Testing

This command allows for Real-Time A/B comparison between any 
number of different schematics opened in SigmaStudio.

Press the real-time A/B-testing icon and when you switch between 
the two (or more) projects, SigmaStudio automatically downloads 
the design B or design A program to the DSP without needing to 
recompile.
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In other words, clicking the icon lets you switch among any number 
of open compiled projects without having to recompile each one. 
(The function is very useful: without it, you must recompile a 
project every time you bring it to the front even if you haven’t 
made any changes to the schematic.)

To switch between open projects, press  Ctrl+Tab or select a 
project name from the main Window menu.

6.3.	Checking amount of resources used

You can monitor the amount of resources used in the project by 
opening the ‘compiler_output.txt’ file, automatically created when 
a Link Compile Download operation is performed. 

The file is located inside the folder projectfolder/IC_1_projectname/ 
net_list_out / compiler_output.txt where projectfolder is the folder 
of the .dspproj file, and projectname is the filename.

6.4.	Storing Presets

Once the DSP project has been downloaded into the DSP, the 
program can be stored on the amplifier through the programming 
board.

In order to store the preset in a specific location among the 4 
available in all Powersoft SigmaDSP based products, proceed as 
follows:

When using an IS version of the amplifier module:

▶▶ Press the preset selection pushbutton on the interface panel 
of the amplifier - if the DSP Programming Board PRO is used, 
the selection can be made by clicking the “Preset select on 
DUT”

▶▶ Press the “Store” button on the programming board

When using a standard version of the amplifier module:

▶▶ If the DSP Programming Board PRO is used, select the preset 
location by clicking the “Preset select on DUT”.

▶▶ If a standard version of the amplifier and the DSP 
Programming Board LITE is used, the Preset selection button 
can be implemented by following the instructions in the 
amplifier’s user manual. Contact support@powersoft.it for 
further support.
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